
Contents
Searching ......................................................................................................4.3

The Search Dialogue ................................................................................4.3
Lists ..............................................................................................4.7

The Current Selection of Records ......................................................4.7
Viewing/Editing items in a list ............................................................4.8
The List Menu Bar ..............................................................................4.9

File Menu......................................................................................4.9
Export ..................................................................................4.9
Chart ....................................................................................4.9
Label ....................................................................................4.9
Quick Letter ..........................................................................4.9
Memos................................................................................4.10

Search Menu ..............................................................................4.10
Show Subset ......................................................................4.10
Omit Subset........................................................................4.10
Show All Records ..............................................................4.10
Search Table ......................................................................4.10
Search Selection ................................................................4.10
Show Products ..................................................................4.10
Search & Replace ..............................................................4.11

Modify Menu ..............................................................................4.16
New Record........................................................................4.16
Delete Selection ................................................................4.16

Deletion Control ........................................................4.17
Un-Delete ..........................................................................4.18
Duplicate Records ............................................................4.18

The Search Editor ..................................................................................4.19
How the Search Editor Works ..........................................................4.19
Saving and re-using a Search ..........................................................4.23
Compound Searches ........................................................................4.24

Sorting ............................................................................................4.26
The Sort Editor........................................................................................4.26

Saving a Sort ....................................................................................4.27
Sorting Tips ............................................................................................4.28

Indexed fields ....................................................................................4.28
What gets sorted ..............................................................................4.28

SEARCHING AND SORTING

V. 4.17 4.1



SEARCHING AND SORTING

4.2 V. 4.17



Two of the most important functions of a database are the ability to search for
a specific record or group of records, and sort them into whatever order is need-
ed for reporting or exporting. CatBase provides plenty of tools to make it easy for
you to find and sort your data in any way you want. 

Note: In this chapter we refer to the database tables by their original names
(Companies, Contacts, Products, and Product Details). These table names may
be different in your database, but you shouldn’t have any trouble figuring out
which ones we are talking about: the Companies table is the one that has infor-
mation such as phone numbers and addresses; the Contacts table is related to
Companies; the Products table contains descriptive information; and the Product
Details table is related to the Product table.

Searching

Whether you need to find a specific record to edit it, create a list of all records
that haven’t been updated in six months, or build a list of all records in a given
category for your next publication, CatBase provides tools to make your search
quick and easy. 

The Search Dialogue
You usually initiate a search via the Search Dialogue window:

The Search Dialogue box will be displayed when you choose any item from
the Data menu or click on a button in the CatBase Options palette, and when you
choose certain items from the other menus. The Search Dialogue provides four
avenues to your data:

Find a specific record, or a group of records that begin with or contain
certain text or other information (such as a particular date):
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This is a field into which you enter some text for CatBase to use as search cri-
teria. The label for this field changes depending upon the item you selected from
the menu bar; in the example shown here, the Products ... item under the Data
menu was selected. We are going to search the Products table.

In most cases, you have a choice of which field you want CatBase to search,
and you make your choice by clicking on the pop-up Search on: menu in the cen-
tre of the dialogue box. The choices in the menu vary according to which table it
is that you are searching. When you are searching the Products table, the choic-
es are:

(Some of the field names may be different in your database.)
If you choose Name, CatBase will use the text that you enter to search for

products with names that begin with or contain (depending on which radio button
is selected) that text. (Note that a “begins with” search will always be faster than
a “contains” search.)

If you choose Category Name, CatBase will search for products for which a
Category containing your entered text has been assigned. (Categories are
explained in detail in Chapter Two, Setting Up Your Database.) 

If you choose Category Number, the search will be as for Category Name
except that you must enter a number instead of text, and CatBase will search for
the Category by number instead of by name.

Choosing No Categories will find all Products which have not been assigned
to any Categories.

If you choose Memo Key, CatBase will search for Product records for which
Memos have been created in which the Key field contains the text you entered.
The search will be restricted to Memos that belong to you or are Public. Memos
are described in Chapter Three.

If you choose Company Name, CatBase will search for Product records that
belong to a company having a name matching the text you entered.

Suppose, for example, that you want to find all products whose names begin
with “Chocolate.” Here’s how to do it:

➢ At the main CatBase screen, choose Products ... from the Data menu, or
click on the Product button in the CatBase Options palette.

✏ When the Search Dialogue appears, type in “chocolate” (without the
quotes). You do not need to worry about capitalisation. Make sure you
don’t get any extra spaces in the text you enter! 

Do you want to search for records that start with the text that you entered, or
that have that text anywhere within the field being searched? That’s what the two
radio buttons are for:
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To initiate the search, you can either:
➢ Press the Enter key on your keyboard, or
➢ Click on the OK button.
CatBase then searches the database for records matching the criteria you

specified, and either presents you with a list of the records it finds or tells you
that it didn’t find any matches.

The choices available for Companies are very similar to those available for
Products:

Company Name of course replaces Product Name, and two additional options,
Contacts Last Name and Contacts Title, have been added. 

The choices available when you choose Export Style Sheets … are:

Style Name is the name that was given to the Export Style Sheet when it was
created.

Creator is the name of the person who designed the Export Style Sheet. To
find all the Export Style Sheets that you designed, choose Creator and enter your
name (as it shown in the Password dialogue box when you launch CatBase).

Base Table is the table on which an Export Style Sheet is based. Export Style
Sheets can be based on:

Companies
Contacts
Products
Company Categories
Product Categories

Please see Chapter 7 for more information on Export Style Sheets.

SEARCHING AND SORTING

V. 4.17 4.5



Sort
You can also specify how you want the records that are found through the

search to be sorted. You do this by making a selection from the Sort pop-up
menu:

The default Sort order is the record name (i.e., Product Name for the Product
table, Company Name for the Companies table, etc.) 

If you are using CatBase Multi-User, sorting a large number of records can be
somewhat time-consuming and can tie up the network. That’s why we have
included “None” as a sort option. If you do not particularly need to have the
records sorted, choose None. This will speed up the time it takes for the records
to be displayed on your screen. Note: If you choose not to sort the records in a
specific order, this does not necessarily mean that they will appear in the order in
which they were entered into the database. This is because when records are
deleted from the database, a “hole” is left in the database where the deleted
table used to be; these holes are then re-used as new records are added.

Create a New Record

Click on this button if you want to create a new record for the table. A blank
record opens up, into which you can enter your data. See the specific chapters in
this manual for the table into which you want to enter data.

Use the Search Editor

Click on this button to use the full-featured Search Editor, which is described
in detail later in this chapter. This lets you search on any field in the table and on
multiple criteria.

All Records

Click on this button if you want to see a list of all the records in the table.
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Lists

When the search is initiated, CatBase searches the appropriate table, and pre-
sents a list of the matching records it finds. The list looks something like this:

Of course, the data displayed in the list varies depending upon which table
you are searching. 

Notice a couple of things about this screen:
• It has its own menu bar. 
• The items in the list are sorted in the order you specified in the Search

Dialogue. If you want to view the records in a different order, you can easi-
ly sort them any way you wish by choosing Sort Selection from the Search
menu. Sorting is explained in detail later in this chapter.

The Current Selection

It’s important that you understand the concept of the Current Selection before
we proceed with this section.

The Current Selection is the list of records that you have selected to view,
edit, print, or otherwise work with. 

When you first create a list of records, the entire list is the current selection.
You can refine that list by selecting records within it and choosing either Show
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Subset or Omit Subset from the Search menu; the resulting list becomes the new
current selection. For example, in the illustration  shown below, four records have
been selected in the list. By choosing Show Subset from the Search menu, only
those four records will be displayed and will become the new current selection.

There are three ways to select records in a list:
1. Press Command (Apple)-A (Mac) or Ctrl-A (Windows) on your keyboard to

select all the records in the list. 
2. To select a group of records:

Click on the first record in the group. It becomes highlighted.
Hold down the Shift key and click on the last item in the group. All records
between the first and second clicks will be selected.

3. To select random items:
Hold down the Command key (Mac) or Ctrl key (Windows) as you click on
individual lines.

Viewing/Editing Items in a List

To view the full record for a line item displayed in a list, double-click anywhere
on that line. The complete data entry screen for the record will open up. From the
data entry screen, you will be able to navigate among the records in the list with-
out returning to the list by using the Record Navigation buttons that are located
at the bottom of every data entry screen. They look like this:
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By clicking on these buttons, you can move directly to the first record in the
current selection, or the previous, next, or last record. This can be very useful if
you want to update a group of records. You can make the necessary change to
the first record, and then click on the Next Record button to move on to the next
record instead of saving the current record and then double-clicking on the next
one to open it. Any changes you have made to a record will be automatically
saved when you use the record navigation buttons. The same page will be dis-
played for each record; if you need to make a modification on the third page of
the product records you have selected, as you move through the list the third
page for each record will be displayed as each record is opened.

The List Menu Bar

The list menu bar has three main menu headings: File, Search, and Modify.

The File menu
The File menu offers the following options:

Export …
You choose this option to export data from CatBase when you are ready to

publish it. Please refer to Chapter 7 for information  on setting up Style Sheets
and Export Style Sheets (which determine how your data will be formatted), and
to Chapter 9 for information on how to export the data.

Chart …
This gives you access to the Chart WIzard, which lets you create charts and

graphs in various styles. The Chart Wizard is described in detail in Chapter 5.

Label …
This option opens up the Label Wizard, which enables you to create mailing

labels. This is described in detail in Chapter 5.

Quick Letter …
Quick Letter is an optional add-on word processing module. With Quick Letter

you can easily produce letters and such, with data from the database merged in.
Quick Letter is also used for creating emails and sending faxes. You will find a
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demo version of 4DWrite (the required plug-in for Quick Letter) on the CatBase
CD; please contact us if you need more information or to order a copy. You will
find basic instructions for using Quick Letter in Chapter 5; a complete manual is
supplied with the product.

Memos …
Memos are described in Chapter 3.

The Search Menu
The Search menu offers these  options:

Show Subset creates a new list containing only the records you selected. This
becomes the current selection. The records are sorted in the order you specified
in the Search Dialogue.

Omit Subset creates a new list consisting of the list that was displayed minus
the line items that were selected. This becomes the current selection. If you start-
ed out with 20 items in the list, selected five of them and chose Omit Subset,
there would then be 15 items displayed. The records are sorted in the order you
specified in the Search Dialogue.

Show All Records creates a list of all the records in the table. The records are
sorted in the order you specified in the Search Dialogue.

Search Table presents the Search Editor, which is explained below. The search
criteria that you enter will be used to search all records in the table. This is not
the same as Search Selection, which is explained next.

Search Selection presents the Search Editor, which is explained below. The
search criteria that you enter will be used to search only the records in the cur-
rent selection. 

Search & Replace is a very powerful feature that makes it possible for you to
make a change in a selection of records all at once. It is available only when a list
of Company or Product records is displayed. This function is described below.

Sort Selection presents the Sort Editor, which is explained later in this chapter.
This lets you sort the current selection of records.

Show Products appears only when you have a list of Company records dis-
played. This menu choice lets you instantly see a list of products that belong to a
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particular company. To use this option:
➢ Create a list of one or more Company records
➢ Click once on ONE company in the list.
➢ Choose Show Products from the Search menu.
CatBase creates a list of that company’s products and displays them in a new

window. If no product records have been entered for the company, CatBase will
tell you so.

Search & Replace
Search & Replace makes it possible for you to make a change in any number

of records all at once. You can:
• Change certain text to something else (for example, change all telephone

dialling codes of 1234 to 01234)
• Change text from mixed case to all uppercase 
• Change text that is all uppercase to mixed case
• Move or copy the contents of one field to another field
• Append the contents of one field to another field

A Word of Warning!
This is a very powerful function. It would be quite possible to do serious dam-

age to your database by using this function carelessly. We urge you to use it with
caution, and to always make a backup of your data file beforehand … just in
case…

To use Search & Replace:

➢ Choose Search & Replace (Command- or Alt-R) from the Search menu. The
following dialogue box opens up:
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➢ Click on the pop-up list of fields to choose the field that you want to per-
form the search & replace on.

If the field you choose is a numeric or Boolean (true/false) field, the Contains,
Is not blank, and is blank radio buttons become dimmed, as do the Change
selected text only and Change entire field radio buttons in the Change To area. 

If the field is Boolean, you must enter True, False, Yes, or No into the text field
and the Change to area.

If the field is a date field, you must enter your search and replace criteria in
the format DD/MM/YYYY (MM/DD/YYYY if you are using the U.S. version).

You cannot perform a search and replace on certain fields, such as record
number, enter date, and modify date.

✏ Enter the value you want to search for into the text field. If you are search-
ing on a numeric field, be sure to enter a number!

If the field you are searching is a text field, you can use any of the radio but-
tons in the search criteria area. 

If the Is not blank radio button is selected, CatBase will search for any
records in which the selected field contains at least one character. Remember
that a space counts as a character!

If the Is blank radio button is selected, CatBase will search for all records in
which the specified field contains no text at all.

If you enter “apple” as your search value and leave the Contains radio button
selected, CatBase will look for any occurrence of the word “apple” anywhere
within the field you have chosen. If there are multiple occurrences of the word
“apple” within the field, each occurrence will be changed. 

If the Is equal to radio button is selected, CatBase will only change records in
which the entire contents of the specified field exactly match the value you have
entered. 

If the All records radio button is selected, every record in the table will be
changed, regardless of what is in the specified field. Use extreme caution when
using this option!

✏ Enter the value that you want the found text changed to into the Change To
area or choose one of the other radio buttons in this area (explained
below).

➢ Leave the Change Selected Text Only radio button selected if you want to
change only the value that was found to the new value.

➢ Select the Change Entire Field radio button if you want the entire contents
of the field replaced by the new text. For example: In the Companies table,
you want to find all occurrences of  “winter catalogue” in the Notes field
and clear all your comments out of the field. You would set up the dia-
logue box like this:
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This will find all records in the current selection of records (or the entire data-
base, if you selected the Search entire table radio button) in which the words
“winter catalogue” occur in the Notes field and clear the field completely in each
record.

However, if you wanted to change the phrase “winter catalogue” to “Spring
catalogue”, you would select the Change selected text only radio button and
enter the text, “Spring catalogue”, into the Change To area.

NOTE that if you select the All Records radio button, the search and replace
action will be performed on all records in the table regardless of whether the
Search selected records only or the Search entire file radio button is selected,
and regardless of the selection of records currently displayed on your screen.

The Change to: area is where you tell CatBase what to do with the matches it
finds:

In the text entry area you enter the text that you want to replace that which
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was found to match the text you entered in the search criteria area above:

All Uppercase
If you want to convert all the text in the field to uppercase, choose the All

Uppercase radio button
When you choose this option, the Change entire field radio button is selected.

Make sure that this is really what you want before proceeding!

Mixed Case
If you want the text converted to mixed upper and lower case, choose the

Upper and Lowercase radio button.

If this option is selected when you click the OK button, you will see an addi-
tional dialogue box after CatBase informs you how many matching records were
found:

First Of Each Word will change the first letter of each word in the field to
uppercase, and everything else to lowercase. This can be useful for such data as
company or product names.

First of each sentence changes the first letter of the first word of each sen-
tence to uppercase, and everything else to lowercase. The first letter of a sen-
tence is defined as any letter which is preceded by one or more spaces, in turn
preceded by a full stop. 

No uppercase converts everything in the field to lowercase.
Cancel stops the search and replace operation.

Move Contents to Field:
This option lets you transfer data from one field to another. As an example,

perhaps you have been using one of the short text fields to maintain certain infor-
mation. But then you realise that the field isn’t big enough, and you want to use a
long text field instead. Using the Move option you could accomplish this very
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easily.
If you select this option, you must select a field to move the data to. 
NOTE: If you are moving data from one type of field to another type of field, it

will be converted to fit the new field format, and you may get unpredictable
results. For example, if you move data from a text field to a numeric field, the pro-
gram will try to convert your text into numbers. If the text is something like “£50”
or £50 and up”, this should be converted to “50” without any trouble. However, if
the text is something like “£50; £55 with additional gadget” the converted number
will probably be 50. 

Copy Contents to field:
This option will make a copy of the contents of the original field in the new

field. In other words, the same text will then appear in both of the fields.

Append contents to field:
Using this option you can add the contents of two fields together. The original

field will remain intact.

The Range Area
In this area, you specify which part of the field you want to change, and which

records to search:

If the Change selected text only radio button is selected, CatBase will change
only the text that exactly matches that which was entered in the search criteria
area.

If the Change entire field radio button is selected, all text in the field will be
changed in the manner you have specified if the text that was entered in the
search criteria area was found anywhere within the field.

Search selected records only
If this option is selected, only the records in the current selection will be

searched.

Search entire table
If this option is selected, the entire table will be searched, regardless of what

records are in the current selection.

➢ When you have set up your Search & Replace criteria, and checked them
carefully to make sure you have done it correctly, click on the OK button.

CatBase performs the search and lets you know how many matching records
it found:
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➢ You can chicken out at this point by clicking on the Cancel button.
If you are brave and want to go ahead:
➢ Click on the OK button.
CatBase does the job and lets you know when it is finished.

Sort Selection
This menu option enables you to sort the records in the list. The Sort editor is

described in detail later in this chapter.

The Modify Menu
The Modify menu offers choices for adding and deleting records in the current

selection:

New Record creates a new record for the current table.
Delete Selection either marks the selected records for deletion, or actually

deletes them, depending upon what the current table is. Company and Product
records can only be marked for deletion through this menu selection; records
from other tables can be directly deleted. This provides a measure of security; if
you want to be able to keep track of Company and Product records that are to be
deleted, and verify that they really should be deleted, you have that control. Once
Company or Product records have been marked for deletion, the Administrator
can view the marked records and confirm that they really should be deleted
before performing the actual deletion. To mark records for deletion:

➢ With a list of Company or Product records on the screen, select the
records you wish to delete.

➢ Choose Delete Selection from the Modify menu.
CatBase asks you to confirm that you want to mark the selected records for

deletion.
➢ Click on OK to continue with the process, or Cancel to abort it.
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What happens next depends upon whether Deletion Control is set to On or Off
in System Preferences.

If Deletion Control is On, you will be required to supply information regarding
why you want to delete the record. The Delete Record screen opens up:

If Deletion Control is On, you must complete one Delete Record for each
record you want to delete. 

✏ Enter a reason for deleting the record, or select one from the pop-up
Reason list.

You can enter an additional note into the Memo field if you wish.
➢ Save the record.
This process will be repeated for each record in the selection.
Please see Chapter 3 for more details on deletion tracking.

Each record that you mark for deletion will have the Delete? check box
checked in the list:

Additionally, when you open a Delete record, its status is indicated in the title
bar:
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If you mark Company records for deletion, all Product records belonging to
each Company will also be marked for deletion.

If you are the Administrator, you can physically delete the records that have
been marked for deletion. This is described at the end of Chapter 3.

Note that if you deleted Company or Product records, the Deletion
Information records (if they exist) are not deleted at the same time. They remain
in the database as a record of what was deleted, and when. You can purge the
Deletion Records by choosing Deletions … from the Admin menu again and click-
ing on the Purge Deletion Records radio button.

Un-Delete
If you have marked a Company or Product record for deletion, but now you

want to restore (or “un-delete”) it, select the record or records you want to
restore and then choose Un-Delete from the Modify menu.

Duplicate Records
Do you need to make one or more duplicates of a record? This menu selection

makes it quick and easy to do so. To duplicate records:
➢ With a list of records displayed on the screen, select the record or records

you want to duplicate.
➢ Choose Duplicate Records from the Modify menu.
CatBase wants to know how many duplicates to make:

You can make up to 99 duplicates. If you enter a number greater than 99,
CatBase will make 99 duplicates.

CatBase makes the duplicates and lets you know when it is finished. Each
duplicate is exactly the same as the original, except that it has been assigned a
new record number. Related records will also be duplicated: these include
Company Contacts, Product Details, Memos, and Categories.
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Searching
Searching is one of the most common database operations. It is often the

most convenient way to select the records with which you want to work.
The term searching refers to finding a group of records in the database based

on the contents of one or more fields. You perform a search by specifying a
query. A query is the set of instructions that tells CatBase which records to
include in the new current selection, such as “Company Name is equal to ACI”.

A query always has three elements: field name, comparison operator, and
value. The field name is from the current table. The comparison operator tells
CatBase how to compare the contents of the field to the value you specify (equal
to, greater than, less than, and so forth). The value specifies the number, string,
or other value to which each record is compared.

Suppose you want to see all the records for products with prices greater than
£10. The query you would use is “Price is greater than 10.” “Price” is the field, “is
greater than” is the comparison operator, and “10” is the value.

When you search the database, CatBase compares the contents of the field in
the query to the value you specify. The new current selection is made up of
records that satisfy the rules stated in the query. The new current selection can
be no records, one record, a group of records, or all the records in the table.

Search Editor

The Search Editor provides a way for you to search any field or fields in the
database.

You can reach the Search Editor either of two ways:
1. By clicking on the Search Editor button in the Search Dialogue;
2. By choosing Search Table or Search Selection from the Search menu when

a list is displayed on the screen.

How the Search Editor works
When you choose the Search Editor, you’ll see a window like this:
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• Searches that you build can be saved for re-use by clicking the Save ...
button.

• To clear the search conditions displayed in the search Editor, choose Clear
from the Edit menu.

This dialogue box is divided into five areas, each of which is described below.

Criteria Area

You do not enter anything directly into the Criteria area; it shows you how the
search will be performed based upon the selections you make in the other areas
on this screen.
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Field Area

The field area lists all the fields in the table on which you are going to conduct
the search. In the example shown here, we are going to search the Companies
table. Notice that some field names are shown in bold type: these fields are
indexed. Searching on an indexed field will be faster than searching on an unin-
dexed field. The Related tables pop-up at the top of the list should be ignored. It
allows you to see other tables than the one on which you will search; however,
you cannot search on those tables

Comparisons Area

In the Comparisons area are listed the various operations that you can use to
evaluate data for the search. 

Value Area
The Value Area is where you enter values for which you want CatBase to

search. For example, if you had selected the field “Price Numeric” and the opera-
tor “is less than,” you would enter a figure, such as “20,” into the Value Area.

The format of the Value Area changes according to the data type of the field
that you selected. For numeric data types, the Value Area looks like this:
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For text data types, the Value area looks like this:

You can enter any text string, including the wildcard character (the “@” sign). 
To make queries easier to specify, CatBase has a wildcard character (@) that

can replace one or more characters in a search involving a Text field. For exam-
ple, if you are looking for all occurrences of the name “Belmondo” in a field, you
may specify the search value in several ways:

Bel@ Finds all values beginning with “Bel”
@do Finds all values ending with “do”
Bel@do Finds  all values starting with “Bel” and ending with “do”
@elm@ Finds all values containing “elm”

Wildcard queries are not case-sensitive. A search for “@F” is the same as a
search for “@f”.

For Boolean data types, the Value Area looks like this:

Conjunction Area
When you search on just one field (as in “Product Name=‘Super Widget’ ”),

that is called a simple search . However, you can search on more than one crite-
rion; that’s called a compound search. To create a compound search, you use
one or more conjunctions:

And finds all records that meet the two conditions simultaneously. For
example, if you build a search condition like this: 
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CatBase will find the records of all companies having names that begin with
the letter “A” and that are in the USA.

Or finds all records that meet either of the two conditions. For example, the
search condition “City is equal to London or City is equal to Manchester” will find
all companies in London or Manchester.

Except is the equivalent of “and not.” The search condition “Product name
contains chocolate except Price Numeric is less than 10” will find all chocolate
having a price greater than or equal to £10.

Building up a compound search
To build a compound search, you select the first criterion, then click on the

Add Line button to add an additional line (or lines).

Doing the search
When you have set up the search criteria, click on either the Query in

Selection or Query button to initiate the search.

Query in Selection
Sometimes you will want to search all the records in the table, and sometimes

you’ll want to search only the records in the current selection (the current selec-
tion is explained earlier in this chapter). The Query in Selection button facilitates
this.

In some cases, this option will be meaningless. If you have arrived at the
Search Editor by clicking on the Search Editor button in the Search Dialogue, the
current selection of records will be empty because you haven’t yet created a
selection. So Query in Selection would tell that there are no matching records.

If you have arrived at the Search Editor by choosing Search Table from the
Search menu in a list of records, clicking the Search in Selection button will cause
the search to be performed on only the records in the current selection (i.e., the
records displayed on the screen). This has the same effect as choosing Search
Selection from the Search menu.

Saving and Re-using a Search Format
Sometimes you’ll want to save a search format so that you can use it again

without having to re-create it. That’s what the Save ... button is for. To save a
search format:

➢ Create the search
➢ Click on the Save button.
A file dialogue box opens up.
➢ Enter a name for the search and save it. We suggest that you create a
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folder within your CatBase program folder for storing search formats.
To restore the search format:
➢ Open the Search Editor.
➢ Click on the Load ... button.
➢ Locate the search format that you saved and open it.

Compound Searches
A compound search is one in which you enter more than one search criteria,

using the And, Or, or Except conjunctions. The conjunctions are explained earlier
in this section.

How compound searches are handled
It’s important to know how a compound search is evaluated by CatBase, as

the order in which the search conditions are created can affect the outcome of
the search. 

The search conditions are evaluated in the order in which they appear in the
Search Editor, i.e., from top to bottom. Consider these two examples:

Example One

Example Two

While both search formats appear to include the same set of criteria, they will
produce different results:

Example One will find all products that either: 
have a name beginning with Chocolate AND are priced at less than £20, 

OR
are made by CatBase

Notice that in this case, since Price Numeric is evaluated before Company
Name, CatBase will find products made by CatBase regardless of a product’s
name or price.

Example Two will find all products that:
have a name beginning with “chocolate” OR are made by CatBase 

AND
are priced less than £20
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In other words, a product must be priced less than £20 in addition to meet-
ing the first two criteria.

TIP!
If you find this confusing, it might be simpler to break the search down into

two or more distinct searches.
For example, first of all search for (for example) all Products having names

that contain “chocolate” and are priced at less than £20.
Then, when you have the results of that search, use Search in Selection to

refine the selection (e.g., to find all records within that selection that are made by
a certain company).
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Sorting

At various times as you are using CatBase, you will want to sort records for
printing, reporting, exporting, etc. This is accomplished via the Sort Editor, which
is shown below. Some actions that you take (such as choosing Quick Label when
you are viewing a list of records) will automatically cause the Sort Editor to
appear; you can also invoke the Sort Editor whenever you have a list of records
on your screen. To do this, choose Sort Selection from the Search menu. 

Sorts that you build in the Sort Editor can be saved for re-use. This is most
useful when you are exporting data; you specify the desired sort order in your
Export Style Sheet, and then you can be sure that the records will always be sort-
ed correctly when you export data using that Export Style Sheet – you won’t have
to remember how they are supposed to be sorted each time you export them.

Sort Editor
The Sort Editor looks like this:

To select a field on which to base the sort, click on the field’s name in the list
of fields on the left, drag and drop it into the area on the right. The Sort Editor will
then look like this:
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Notice the text “Asc.” to the right of the field name. This indicates the sort
order – ascending in this case. To change the sort order to descending, click on
the “Asc.” text; it will change to “Dsc.”, and the records will be sorted in
descending order.

You can sort on any number of fields at once. The order in which the fields are
selected determines the hierarchy of how the records will be sorted. In the follow-
ing example, the records will be sorted first by country and then, within each
country, by company name.

Saving a Sort
To save a sort, click on the Save button. 
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Doing the Sort
Click on the Sort button to perform the sort.

Sorting Tips
Indexed Fields
Sorting on an indexed field will be much faster than sorting on an unindexed

field. 

What gets sorted
When you sort a selection of records, only the order in which the records are

displayed changes; the order in which they are stored in the database does not
change. For example, if you use the Search Editor to select a group of records
and sort them into alphabetical order, the order of the records in the physical
table has not changed — only the order in which they are currently displayed. If
you change that selection of records, either by using the Search Editor again or
by using Show Subset or Omit Subset to refine the selection of records, the new
selection will be displayed in the order that you specified in the Search Dialogue.
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